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1  FIGURE 4 STANDALONE BEST PRACTICES PRINT MATERIAL QUICK
REFERENCE

You can you use the following chart as a one-stop shop for all Figure 4 print material information. To print this page, scroll to
the bottom and click the Printer-friendly Version Link. On the page in the new tab, press ctrl+P (cmd+P on Mac) to print the
document. For best results, set up the print in landscape orientation and 50% scale.
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

General Tips for All
Materials

1. For best results,
orient part to
try and
maintain
uniform wall
thickness.

2. For full
platforms and
parts with cross
sectional areas,
print quality is
best in
Premium
mode. Or add
1-2 seconds to
slow down the
Interval Pause
Time and the
Interval Down
Time in the
Build Style by
an extra 1-2
seconds.

3. Use Standard
Thick mode for
thick parts or
densely packed
print platform.
Thick part for
example is
20x20x10.

4. Use orientation
to minimize
large cross
sections areas.
Orient parts per
best practices
and on
YouTube
Module 3 & 4
tips.

5. Large flat
bottom
surfaces can be
improved by
increasing cure
depth from
10-20%,
pending effects
of fine features.

6. Verify all holes,
bosses, and
fine features
are supported
properly when
using auto-
generated
supports. If
support issues
occur, increase
density of
supports and
tip ratio.

7. Ensure parts
are not
supported on a
line of
supports. Best
results have
three supports
similar to a
tripod
preventing the
part from
moving side to
side during the
print.

8. For large parts,
dense arrays of
parts, or
negative
features in
bottom of part,
you might wish
to clean the
parts while still
on the print
platform. If this
is the case,
increase
Minimum
Support Height
to 5-7 mm to
make cleaning
under the parts
easier.

9. May need to
remove the
bottom of bulk
of supports
(not tips) before
cleaning.
Allowing part to
dry before
removing
supports allows
for less
scratching of
part.

10. After a curing
cycle in the
LC-3DPrint Box,
the glass plate
inside will be
hot. To prevent
part warping,
avoid placing
green parts on
the glass plate
when it is still
hot. For best
results on large
or flat parts:

a. Post-cure
for 20
minutes on
the build
platform
and allow
five minutes
to cool.

b. Remove
part from
build
platform
and remove
supports.

c. Cure the
part on the
glass for the
standard
amount of
time listed
in the chart
below.

n/a n/a n/a n/a

3D Systems, Inc. 2 p/n 42-D113, Rev. N

https://support.3dsystems.com/s/article/figure-4-standalone-video-library-landing
https://support.3dsystems.com/s/article/figure-4-standalone-video-library-landing


PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® Tough
Clear

3D Sprint Tips

1. General Best
Practices apply

2. Bubbles are not
uncommon in
clear
photopolymers.
They are most
common in
thick walled
geometries or
densely packed
build plates. To
help reduce
bubbles, try
reducing part
density on the
plate as well as
proximity to the
center of the
plate.

Overhangs and
Self-Supporting
Angles

1. Overhangs
larger than .8
mm, may
require
additional
supports.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

n/a

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

60 min. ( see Note
2 )
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MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® RIGID
140C Black

3D Sprint Tips

1. General Best
Practices apply

2. Default layer
thickness for
accuracy is at
30um layer
thickness.

3. Orient small
holes
(0.5-1mm)
parallel to the
plate when
possible.

4. For best results
space parts at a
minimum of
10mm apart.

Material Tips

1. Material is a 2-
part epoxy/
acrylate hybrid
with an A&B
part that must
be mixed at
19:1 ratio

2. Mix new
amount for
each print
unless in the
SAME day

3. Material
Amount = Part
Est+100g+
(Est*15%)

4. May need to
add 20% rather
than 15%
pending
density of print
or part

Post Processing
Tips

1. Rinse with
water - If TPM is
not rinsed with
water, the part
may get blue/
white marks on
the sidewalls.

2. IPA Clean - To
prevent
degrading the
elongation-at-
break
properties, do
NOT exceed
recommended
time in IPA (1-2
minutes).

3. Thermal post
cure requires a
three-hour hold
at 130°C to fully
cure the parts.
Do not exceed
three hours for
post curing.

3D Sprint YouTube
Videos

Click here for
full material best
practices

See Special
Considerations for
Rigid 140C Black.

Post-Processing
Guide

Cleaning Charts

See Special
Considerations for
Rigid 140C Black.
( see Note 2 )
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MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
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PART-CLEANING
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PART-CURING
TIME

Figure 4® PRO-BLK
10

1. General best
practices apply.

2. When printing
thick parts or
very dense
platforms, use
Premium Plus
for best results.
Note mode will
be ~2x slower
but can provide
very good part
quality.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )

Figure 4® Rigid
White

1. General Best
Practices apply

2. Place parts a
minimum of 8
mm apart to
improve
material flow
and adhesion.

3. If adhesion
issues occur,
raise the Base
Layer Curing
Time to 100
seconds. It may
also be
necessary to
change Base
Truss Infill Type
to 'Solid' rather
than
'Connected
Solid'.

4. If printing flat
surfaces,
reduce the
Interval
Distance to 3-5
mm to improve
pillowing effect.
Adding some
supports will
also improve
the part.

5. When printing
thick parts or
very dense
platforms, use
Premium Plus
for best results.
Note - mode
will be ~2x
slower but can
provide very
good part
quality.

Click here for
full material best
practices

3D Sprint YouTube
Videos

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use and
each morning - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )
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MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® RIGID
GRAY

1. General best
practices apply.

2. For best results
use the Resin
Mixer to gently
stir between
prints and after
the resin has
been sitting
overnight.

CAUTION:
Do NOT
press
down on
the film
when
stirring.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )

Figure 4 HI® TEMP
300-AMB

1. General best
practices apply.

2. Manual clean
only - do not
use sonication.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

no mixing
necessary

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )

Figure 4® High
Temp 150C FR
Black

1. General best
practices apply.

2. For best results
use the Resin
Mixer to gently
stir between
prints and after
the resin has
been sitting
overnight.

CAUTION:
Do NOT
press
down on
the film
when
stirring.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® TOUGH
65C BLACK

1. General Best
Practices apply

2. When printing
thick parts or
very dense
platforms, use
Premium Plus
for best results.
Note mode will
be ~2x slower
but can provide
very good part
quality.

3. For best results
space parts at a
minimum of
10mm apart.

4. Avoid printing
parts flat.
Orient parts for
better flat
surfaces.

5. Parts, before
and after cure
can be easily
scratched and
show up on
part surfaces.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )

3D Systems, Inc. 7 p/n 42-D113, Rev. N
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PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
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PART-CURING
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Figure 4® TOUGH
60C WHITE

1. General Best
Practices apply.

2. For best results
use the Resin
Mixer to gently
stir between
prints and after
the resin has
been sitting
overnight.

CAUTION:
Do NOT
press
down on
the film
when
stirring.

3. When printing
thick parts or
very dense
platforms, use
Premium Plus
for best results.
Note mode will
be ~2x slower
but can provide
very good part
quality.

4. For best results
space parts at a
minimum of
10mm apart.

5. Avoid printing
parts flat.
Orient parts for
better flat
surfaces.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )
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Figure 4®

RUBBER-65A BLK
1. General Best

Practices Apply.
2. Remove parts

from platform
after printing.
After 12 hours,
large parts can
detach from
print platform
and fall into
material tray.

3. Parts should be
cleaned and
cured soon
after removing
from the
printer for best
results.

4. Aged material
may have a
different color
hue, but it does
not affect part
building or
usage.

Click here for
full material best
practices

3D Sprint YouTube
Videos

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )
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Figure 4® RUBBER-
BLK 10

1. General best
practices apply.

2. Material is soft
when green.
You must orient
it in 3D Sprint
to allow for the
maximum
number of
support
locations.

3. Tall parts (>100
mm) print best
at 30 µm layer
thickness.

4. Take care when
handling green
parts due to
their flexible
nature.

5. IPA does not
dissolve this
material.
Propylene
Carbonate
must be used
when cleaning
printed parts.
IPA should only
be used as a
final rinse.

6. Parts can be
sticky until post
cured.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )

Figure 4® FLEX-BLK
20

General best
practices apply.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® MED-
AMB 10

1. General best
practices apply.

2. To avoid
chipping
printed part
during post
processing, do
not support
part too close
to its edges in
3D Sprint.

3. To avoid areas
of color
differences on
your parts,
space parts well
in LC-3DPrint
Box to avoid
parts casting
shadows on
each other.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 5 min.

After 1st use - 5
min.

( see Note 1 )

Mix resin in
resin tray before
printing

In tray < 3 hr - 10
sec.

In tray > 3 hr - 30
sec.

Post-Processing
Guide

Cleaning Charts

60 min. ( see
Note 2 ) - After
curing, sterilize
in autoclave
according to User
Guide.
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® MED-
WHT 10

1. General best
practices apply

2. To avoid
chipping
printed part
during post
processing, do
not support
part too close
to its edges in
3D Sprint.

3. For best results
use the Resin
Mixer to gently
stir between
prints and after
the print
material has
been sitting
overnight.

CAUTION:
Do NOT
press
down on
the film
when
stirring.

4. Must keep
clean bath of
IPA to reduce
color changing.
Best to keep
white material
separate form
other material
to avoid color
contamination

5. White pigment
is very difficult
to clean off
print platforms.
Soak print
platforms in
solvent, and
then wipe with
solvent-wetted
towels.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Before Pouring

New bottle - Hand-
shake for 5 mins.,
then place on
LC-3DMixer for 2.5
hr.

After 1st use -
Hand-shake for 5
mins., then place
on LC-3DMixer for
1 hr.

( see Note 1 )

Mix resin in
resin tray before
printing

In tray < 3 hr - 30
sec.

In tray > 3 hr - 60
sec.

Post-Processing
Guide

Cleaning Charts

60 min. ( see
Note 2 ) - After
curing, sterilize
in autoclave
according to User
Guide.
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4®

EGGSHELL-AMB 10
1. General best

practices apply.
2. When using

parts to create
injection molds,
keep supports
on the part to
hold it steady
during injection
and current
process of
silicones.

3. There are many
commercial
silicone and
RTV materials
used for
eggshell
molding. Use
the following
during post-
processing with
EGGSHELL-AMB
10 to improve
any inhibition
issues:

a. Clean parts
as seen in
the Post
Processing
Guide . Dry
out parts in
between
cleanings to
remove
residual
material/
IPA. If
material/
sticky spots
still exist
after two
cleanings,
spray IPA on
the affected
area(s) of
the part and
blow dry.

b. Dry parts in
an oven at
60°C (140°F)
for one hour
before post
curing.

c. Post-cure
parts for 90
minutes.

d. Reheat
parts in an
oven at 80°C
(176°F) for
30 minutes,
or 60
minutes if
the part is
larger or
more-
complex.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

no mixing
necessary

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® TOUGH-
BLK 20

General best
practices apply.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® JEWEL
MASTER GRY

1. General Best
Practices apply.

2. Due to the
delicate
geometry of
jewelry, it is a
best practice to
use the Modify
tab to Add/
Remove
supports for
optimal
outcome.

3. Use the cure
depth
adjustment
under the
Advanced
section of the
Build Style
window to
resolve fine or
negative
features when
necessary.
Adjustments
should be
within 10-20
µm increments.

4. IPA already
dirty with Jewel
Master GRY
resin cleans
slightly better
than using only
fresh IPA. Using
a two-step dirty
IPA/clean IPA
cleaning
process works
best.

5. Remove
support tips
before part is
completely dry
to avoid
damaging the
part.

6. Post cure parts
before sanding
support nibs
flush. Parts are
weaker than
supports prior
to post curing.
After post
curing, parts
and supports
have equal
strength and
sanding gives
the desired
result.

Click here for
full material best
practices

3D Sprint YouTube
Videos

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

60 min. ( see Note
2 )
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® TOUGH-
GRY 10

1. General best
practices apply.

2. For best results
use the Resin
Mixer to gently
stir between
prints and after
the resin has
been sitting
overnight.

CAUTION:
Do NOT
press
down on
the film
when
stirring.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

60 min. ( see Note
2 )

Figure 4® TOUGH-
GRY 15

1. General best
practices apply.

2. For best results
use the Resin
Mixer to gently
stir between
prints and after
the resin has
been sitting
overnight.

CAUTION:
Do NOT
press
down on
the film
when
stirring.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1see
Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

90 min. ( see Note
2 )
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® ELAST-
BLK 10

1. General Best
Practices Apply.

2. Remove parts
from platform
after printing.
After 12 hours,
large parts can
detach from
print platform
and fall into
material tray.

3. Parts should be
cleaned and
cured soon
after removing
from the
printer for best
results.

4. Aged material
may have a
different color
hue, but it does
not affect part
building or
usage.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

45 min. ( see Note
2 )
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® JCAST-
GRN 10

1. Manually check
support
locations in 3D
Sprint before
printing.

2. In thicker cross
sections for
large rings or
non-ring
geometries, go
up in cure
depth to avoid
delamination
between layers.
Go up in 10 µm
increments to
prevent over
curing features.

3. For full
platforms and
parts with cross
sectional areas,
print quality is
best in
Premium
mode. Or add
1-2 seconds to
slow down the
Interval Pause
Time and the
Interval Down
Time in the
Build Style by
an extra 1-2
seconds.

4. If positive
features have
poor resolution,
the Border
Thickness
parameter in
the build style
could be
increased up to
20%. It is not
suggested to
go higher, or
negative
features might
get closed or
too small.

5. If detail is
blurry, verify
proper cleaning
method. Ensure
cleaning
solvents are not
saturated and
parts are
allowed to dry
before post
curing.

6. If detailing is
still blurred,
lower cure
depth in 10 µm
increments.

7. If detail
remains an
issue, or
accuracy is
hard to achieve,
run the
accuracy wizard
for this build
style.

8. Make sure all
IPA has
evaporated off
after part
cleaning, and
allow for parts
to dry
completely. If
surface finish is
still shiny (not
matte) after
cleaning, not all
print material
has been
removed and it
will show up in
the casting.
Repeat cleaning
and drying until
parts do not
have any excess
material.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

30 min. ( see Note
2 )
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PRINT
MATERIAL

MATERIAL TIPS 3D SPRINT
ORIENTATION /
SUPPORTS
GUIDES

PRINT
MATERIAL
MIXING
INSTRUCTIONS

PART-CLEANING
INFO.

PART-CURING
TIME

Figure 4® FLEX BLK
10

1. General best
practices apply.

2. Orient part in
3D Sprint to
such that flat
surfaces are
not parallel
with the print
platform. Flat
surfaces may
show more
support
scarring than
other Figure 4
materials.

3D Sprint YouTube
Videos

Click here for
full material best
practices

Pre-mix resin on
LC-3DMixer before
pouring

New bottle - 1 hr.

After 1st use - 10
min.

( see Note 1 )

Mix resin in
resin tray before
printing

30 sec.

Post-Processing
Guide

Cleaning Charts

60 min. ( see Note
2 )

Note: 1: Considerations for resin that has been sitting, unused, for over 1 month - If you have a resin bottle
like this, simply treat it like a new bottle and mix it for the time specified in the "Brand-new bottle" column in
the above chart.

Note: 2: Ensure that you place the build in your UV curing oven in the same orientation it was printed in, as if
the bottom of the oven is the print platform.

3D Systems, Inc. 19 p/n 42-D113, Rev. N

https://support.3dsystems.com/s/article/figure-4-standalone-3d-sprint
https://support.3dsystems.com/s/article/figure-4-standalone-3d-sprint
https://support.3dsystems.com/s/article/figure-4-standalone-figure-4-flex-blk-10
https://support.3dsystems.com/s/article/figure-4-standalone-figure-4-flex-blk-10
https://support.3dsystems.com/s/article/figure-4-standalone-figure-4-flex-blk-10
https://support.3dsystems.com/s/article/figure-4-standalone-post-processing
https://support.3dsystems.com/s/article/figure-4-standalone-post-processing
https://support.3dsystems.com/s/article/figure-4-standalone-cleaning-chart


2  FIGURE 4 STANDALONE BEST PRACTICES GENERAL POST-
PROCESSING TIPS

1. For large parts, dense arrays of parts, or negative features in the bottom of part, you might wish to clean the parts while
still on the print platform. If this is the case, increase Minimum Support Height to 5-7 mm to make cleaning under the parts
easier.

2. You may need to remove the bottom bulk of supports (not tips) before cleaning. Allowing the part to dry before removing
supports allows for less scratching of the part.

3. After a curing cycle in the LC-3DPrint Box, the glass plate inside will be hot. To prevent part warping, avoid placing green
parts on the glass plate when it is still hot. For best results on large or flat parts:

a. Post-cure for 20 minutes on the print platform and allow five minutes to cool.
b. Remove the part from the print platform and remove the supports.
c. Cure the part on the glass for the standard amount of time listed in the quick-reference chart .

4. Green parts should be handled with care to prevent scratching of them. Cleaning, drying, and post curing on the print
platform can help this as well.
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3  FIGURE 4 STANDALONE BEST PRACTICES 3D SPRINT

General Tips for 3D Sprint Supports

1. Each material has customized support styles. Follow best practices as a starting point for supporting a part.

2. Check the support location using the Modify Tab in Smart Support to remove and/or add any supports based on the
geometry and application before printing.

3. Click the Help Icon to see detailed help on all support styles and parameters.

Note: If two materials have a support style with the same name, the settings are still custom to each material
and will be different.

3.1 Figure 4 Standalone Best Practices Materials

3.1.1 Figure 4 TOUGH CLEAR
Figure 4® Tough Clear - A clear, production-grade material engineered to offer long-term environmental UV, humidity stability,
and clarity that avoids fading or discoloration for up to 8 years.

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.

CAUTION: Do NOT press down on the film when stirring.

3. Use the punching tool provided in the post processing kit from your Figure 4® printer and remove parts from the build plate.
Parts can be scuffed or scratched in the green state, so handle with care.

4. Sonication can be used to help clear resin from channels and crevices.
5. Before UV-curing, let parts dry at 35°C for 25 minutes or at ambient temperature on a mesh wire drying rack in a ventilated

area for at least 60 minutes. All IPA must be evaporated before UV-curing.

Orientation

Please see Orientation section for TOUGH-GRY 10.

Supports

Fine Flat Tip

Best for lightweight small to medium parts

Large covers or thin, long, down-facing surfaces should be supported with the General Round Tip support style to reduce curl.
Additional support anchors are recommended.

General Round Tip - Default

General Purpose - Best for medium-to-large heavy parts

3.1.1.1 Best Practices

The purpose of this document is to provide best practices for preparing a print for the Tough Clear material. The Tough Clear
is a new Digital Light Processing (DLP) material that showcases optimal part clarity. The new material also will need to be
prepared for printing, handled, and post processed with care to allow for the user to get these properties from the final part.

Note: While this document is best practices for Tough Clear, many are also best practices for standard DLP
materials.

3.1.1.2 Maximum Z-height

Tough Clear has a pump height of 15mm. Due to this, the maximum height that a part can be is 179mm for Standalones and
329mm for Modulars.
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3.1.1.3 Supports

Properly supported parts are critical to final part accuracy, and print reliability. To properly setup and support the parts, use
the SMART SUPPORT feature in 3D Sprint for generation of support structures. The image below demonstrates the two support
generation styles available. The Default style is the General Round Tip style for general printing and the fine flat tip for more
delicate parts and less support scarring

Use the table below to select the style in the SMART SUPPORT and Support Build Style that best works for the parts being built:

SUPPORT
STYLE:

WHEN TO USE: CURE ON
PLATFORM:

PROS CONS

Fine Flat Tip,
General Support
Style

Lightweight, Small to
Large Parts

Only if easy access to
supports, otherwise
remove before curing

• Less support
scarring

• Better bottom
Surface

• Unable to support heavy
solid parts

General Round
Tip, General
Support Style

General Purpose, Medium
to Large Parts (heavy)

• Stronger hold of part • Scarring
• Bottom surface

Some parts in figure 4 tough clear may benefit from more densely spaced supports. The default starting points for General
Round tip and Fine Flat tip are a good starting point. If you find some parts show evidence of under supported features,
try decreasing point influence radius or placing additional manual supports. Overhangs and Large flat areas are particularly
susceptible for tough clear.
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Keep in mind when deciding whether to remove the part from the supports prior to curing that this material is easily scuffed,
and handling should be minimized in the green state to avoid fingerprints or marks. However, if supports are in small crevices,
it is recommended they be removed prior to curing to avoid any scratches of the cured surface upon retrieval.

3.1.1.4 Overhangs and Self-Supporting Angles

Tough Clear parts are easily removable from the supports, but parts may require additional supporting for overhangs/flat
surfaces. The supports do create a more noticeable mark on the part than other materials, but do not risk the security of the
build by reducing the number of attachment points.

Depending on geometry, flat overhangs larger than 0.8 mm may have trouble resolving. It is recommended to add supports to
any overhanging feature. Alternatively, the part can be rotated so the overhang is no longer flat. A starting point of 30 degrees
is recommended to allow overhangs to become “self-supporting”.
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3.1.1.5 Best Practices to Prevent Print Distortion
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3.1.1.5.1 Tall, Straight Features

Thin plates may require sturdier supporting, use General Round Tip and additional support anchors in circled area for optimal
results.

For thin wall parts be sure to add additional supporting along the side walls, and near the edges of the part (see red circles), as
this is where deformation tends to originate.

By adding additional supporting to the bottom edges, the part has a straight 90-degree angle
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3.1.1.5.2 Bubbles

The image above shows a part in the middle of the platform and exhibits bubbles leading up the center of the part, while the
image below shows a part closer to the edge of the platform with no bubbles present.

3.1.1.5.3 Heat Distortion

Heat will distort thin wall parts so make sure the parts are self-supported in the chamber. Elevate the glass tray in the
LC-3DPrint Box by ~75mm to move the parts away from the heat of the bulbs.

No matter which UV method you choose, allow the parts to return to ambient temperature before removing them to avoid
shocking them. This can possibly lead to further distortion of the part.

3.1.1.5.4 Part Finishing

Secondary processes on post-cured parts can expand the part application capability. Some examples of these secondary
processes are painting, plating, bead blasting, sand-blasting, or water honing.

• Parts can be finished using standard finishing techniques, such as sanding and filing.
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• Sanding and water honing followed by dipping in a clear coat has shown to be a good finishing method to clean up parts
and produces a glossy finish.

3.1.2 Figure 4 EGGSHELL-AMB 10
Figure 4™ EGGSHELL-AMB 10 is a rigid plastic used to create sacrificial tooling that withstands silicone injection at high
temperature and pressure, but breaks away easily

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. When using parts to create injection molds, keep supports on the part to hold it steady during injection and current process

of silicones.
3. There are many commercial silicone and RTV materials used for eggshell molding. Use the following during post-processing

with EGGSHELL-AMB 10 to improve any inhibition issues:

a. Clean parts as seen in the Post Processing Guide . Dry out parts in between cleanings to remove residual material/IPA. If
material/sticky spots still exist after two cleanings, spray IPA on the affected area(s) of the part and blow dry.

b. Dry parts in an oven at 60°C (140°F) for one hour before post curing.
c. Post-cure parts for 90 minutes.
d. Reheat parts in an oven at 80°C (176°F) for 30 minutes, or 60 minutes if the part is larger or more-complex.

Orientation

Please see Orientation section for TOUGH-GRY 10.

General Round Tip

• Best for general use for small parts up to large and large-cover parts.
• When printing small, fine parts in this material, the user may need to modify the Pillar Tip Ratio.

3.1.3 Figure 4 ELAST-BLK 10
Figure 4™ ELASTIC-BLK 10 is a material suited for the prototyping and design of a wide variety of elastomeric parts. Producing
parts in a fraction of the time required to produce molded parts, this material accelerates the design and iteration of new
concepts with rubber-like functional prototypes for industrial and consumer goods applications.

Accuracy Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. Remove parts from platform after printing. After 12-hours large parts can detach from print platform and fall into material

tray.

Orientation

Please see Orientation section for TOUGH-GRY 10.

Best for general use for medium sized parts up to large and large-cover parts.

General Flat Tip Supports

Please see General Flat Tip Supports section for TOUGH-GRY 10.

Fine Flat Tip Supports

Please see Fine Flat Tip Supports section for TOUGH-GRY 10.

Additional Tips & Tricks

Please see Additional Tips & Tricks section for TOUGH-GRY 10.

3.1.4 Figure 4 FLEX-BLK 10
Figure 4™ FLEX-BLK 10 is a material suited for prototyping, and offers high strength and stability for production applications.
Producing parts in a fraction of the time required to produce molded parts, this material accelerates the design and iteration of
new concepts with flexible, durable, functional prototypes for industrial and consumer goods applications.
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General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. Orient part in 3D Sprint to such that flat surfaces are not parallel with the print platform. Flat surfaces may show more

support scarring than other Figure 4 materials.

3.1.5 Figure 4 FLEX-BLK 20
Figure 4™ FLEX-BLK 20 is a flexible, high impact-resistant material for extremely durable black parts, with the look and feel of
production polypropylene.

General Tips

General best practices apply, as seen in the Figure 4 Print Material Quick Reference .

Orientation

Please see Orientation section for TOUGH-GRY 10.

General Round Tip

• Best for general use for small parts up to large and large cover parts.
• When printing small, fine parts in this material, the user may need to modify the Pillar Tip Ratio.

Additional Tips & Tricks

Please see Additional Tips & Tricks section for TOUGH-GRY 10.

3.1.6 Figure 4 High Temp 150C FR Black
Figure 4® High Temp 150C FR Black - A rigid, fire-retardant resin that can be used for production of parts requiring UL 94 V0
capability as well as FAR Part 23.853 and FAR 25.853 capability

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. For best results use the Resin Mixer to gently stir between prints and after the print material has been sitting overnight.

CAUTION: Do NOT press down on film when stirring

Orientation

Please see Orientation section for TOUGH-GRY 10.

Supports

General Round Tip - Default

Best for general use for medium sized parts up to large and large cover parts.

Post Processing

1. General Best Practices apply
2. Manual clean ONLY, do not use sonication
3. Parts can scratch easily in the green state; so take care while cleaning not to have multiple parts crowded together and

rubbing against each other.
4. Due to the lack of sonication, a soft bristled brush and/or IPA squirt bottle may be required to clear small crevices of

uncured resin.

3.1.7 Figure 4 HI TEMP 300-AMB
Figure 4™ HI TEMP 300-AMB is an industry-leading, ultra-high-temperature-resistant (HDT > 300°C), rigid plastic suitable for the
harshest environments
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Material Tips

For Premium Mold Build Style

1. Orient parts on angle for best results.
2. Make mating parts angles the same for each mold part for best matching parts
3. When coring out mold halves, use a honeycomb hatch/rubbing pattern with no sharp corners.
4. Insure no debris is in material tray before print to avoid causing part defects which could lead to cracks. Filter material with

paint filter can help.
5. Insure no debris is on print plate before print.
6. When making large inserts for molds

a. Modify model to add 500um to front and back face and mill off to ensure flat
b. For larger molds core out mold half and fill with aluminum epoxy for added cooling.
c. Mill off to be flat.
d. When coring out, minimize ribs to maximize amount of aluminum epoxy to contact reverse side of the mold surface

7. Print times can be +12 hr builds

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. Manual clean only - do not use sonication.

Orientation

Please see Orientation section for TOUGH-GRY 10.

Fine Flat Tip Best for general use for fine small parts up to large and large cover parts

General Flat Tip Best for large heavy duty parts needing more robust tips. Check coverage before printing.

General Round Tip Best for when reliability is a must such as tensile bars, and accuracy blocks

General Round Tip Mold Best to use for Premium Mold build style for reliability

3.1.8 Figure 4 JCAST-GRN 10
Designed for the jewelry casting professional, Figure 4™ JCAST-GRN 10 produces accurate, reproducible, and highly detailed
master patterns for jewelry casting. This high contrast green material is easy to cast with minimal ash and residue, producing
high quality jewelry pieces rapidly.

General Tips

1. Manually check support locations in 3D Sprint before printing.
2. In thicker cross sections for large rings or non-ring geometries, go up in cure depth to avoid delamination between layers.

Go up in 10 µm increments to prevent over curing features.
3. For full platforms and parts with cross sectional areas, print quality is best in Premium mode. Or add 1-2 seconds to slow

down the Interval Pause Time and the Interval Down Time in the Build Style by an extra 1-2 seconds.
4. If positive features have poor resolution, the Border Thickness parameter in the build style could be increased up to 20%. It

is not suggested to go higher, or negative features might get closed or too small.
5. If detail is blurry, verify proper cleaning method. Ensure cleaning solvents are not saturated and parts are allowed to dry

before post curing.
6. If detailing is still blurred, lower cure depth in 10 µm increments.
7. If detail remains an issue, or accuracy is hard to achieve, run the accuracy wizard for this build style.
8. Make sure all IPA has evaporated off after part cleaning, and allow for parts to dry completely. If surface finish is still shiny

(not matte) after cleaning, not all print material has been removed and it will show up in the casting. Repeat cleaning and
drying until parts do not have any excess material.

Orientation

The orientation for thick parts is best when oriented vertically to minimize supports.
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Figure 1. Ring print orientation in 3DSprint

Add Supports - Full Arches

Add supports to the part using the Create Supports function under the Smart Supports icon. Look at the supports and
determine how they may need to be modified.

Jewelry parts will need to be checked manually to verify supports are on the correct part of the rings to prevent damage to the
part during support removal. In 3DSprint start by viewing the rings from the bottom-up.

Thin and Multiple band Ring Geometry

Rings with thin bands and multiple band ring geometry need to be properly supported to maintain roundness and all bands of
the ring band.

Figure 2. Ring view from bottom-up.

Go to the Analyze tab in the Smart Supports and Update Placement to view the default supports. Many of these supports will
need to be removed.
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Figure 3. Default support placement.

After loading the default supports go to the Manual Tab to remove supports. Remove the supports that are on the crown. Note
also that this part of the ring is mostly self-supporting. The reason the software adds these supports is that the default supports
must cover all general parts. Thus, the support coverage will be conservative for reliability.

Figure 4. Manually edited support removal result.

Use the Clipping function in the View window to scroll thru the part to see if any anchor points are on the inside that need to be
removed.
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Figure 5. This ring has many anchor points that need to be removed from the inside of the part.

Figure 6. This ring has the anchor points removed from the inside of the part.

Next be sure to remove anchor points from features that can be self supporting.
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Figure 7. The ring on the right has the feature anchor point removed.

The band and underside of the crown are the ideal places to support. This is because support removal is easy and less likely to
scar the part in these areas. Support the extra bands with more anchor points at the starting area of the ring.

Figure 8. Anchor points added to starting point 2nd and 3rd bands of the ring.

To maintain roundness of the part during printing, add anchor points at intervals going up the ring sides. In sure all bands of
the ring are supported.
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Figure 9. Anchor points added to starting point 2nd and 3rd bands of the ring.

Figure 10. Ring with final support solution.
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Figure 11.The Pillar Top Ratio parameter is highlighted with a star.

Figure 12. Note the support tip change by making the Pillar Top Ratio 0.3 rather than 0.15.

Wide Band Ring Geometry

Rings with wide bands require more anchor points on the bottom half of the ring band. This will help maintain the roundness of
the ring and control the shape of the bottom of the ring to minimize post processing.
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Figure 13. Wide band ring.

The default anchor points on the ring band will not be enough to maintain the shape. Note because the manual support editing
is necessary, the 3DSprint software defaults to less supports so removing supports and adding supports is easier for the user.

Figure 14. Default anchor points on thick ring band.
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Figure 15. Modified anchor points on thick ring band.

3.1.9 Figure 4 JEWEL MASTER GRY
Designed for the jewelry casting professional, Figure 4™ JEWEL MASTER GRY produces accurate, reproducible, and highly
detailed master patterns for jewelry casting in silicone using the Master Pattern print mode. Figure 4 JEWEL MASTER GRY
also produces fast, high-quality jewelry prototypes to demonstrate jewelry designs to customers using the Prototype print
mode. The gray color reveals ultra-fine detail and surfaces, while the material properties are specifically suited for producing
high-quality silicone molds.

General Tips

1. General Best Practices apply.
2. See the FAQ below if you are experiencing printing failures.
3. The most important factor to ensure printing success is getting the supports correct.
4. Check the catch-tray glass inside the printer often and clean as needed.
5. Pour unused print material through a paint strainer funnel to remove any print debris to keep material in optimal condition.

Follow the recommendations here for funnel usage.
6. Use the JEWEL MASTER GRY Master Pattern support style with the 30µm Master Pattern print mode to print high-resolution,

master-pattern parts.
7. Use the JEWEL MASTER GRY ProtoType support style with the 50µm ProtoType print mode to quickly print lower-resolution

prototype parts.
8. The JEWEL MASTER GRY print modes are optimized for jewelry type parts. These print modes may not be reliable for

large, non-jewelry type parts. Increase cure depth as needed to avoid delamination between layers. Add 1-2 seconds to the
Interval Pause Time and the Interval Down Time values to improve printing reliability. Use the general purpose support
styles instead of the jewelry support styles for non-jewelry type parts.
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Orientation

1. Orient thick parts to minimize part cross-sectional area.
2. Orient parts so part layers are mostly self-supporting

during printing.
3. Orient parts so supports scars land on surfaces and

locations that are easily sanded.
4. Increase part-base Z-height from 3mm to 5mm for easier

cleaning and part removal.
5. Orient rings at 45° to minimize pixel stepping for optimal

print quality.

Figure 1. Ring orientation example in 3D Sprint

Add Supports

Add supports to the part using the Create Supports function under the Smart Supports icon. Examine the support contact
points to ensure parts are properly supported and determine where points need to be added and removed. In 3D Sprint, start
by viewing the rings from the bottom-up.

Thin-Ring Supports

The example below demonstrates supporting a thin ring for optimal printing reliability and print quality.

Figure 2. Example ring user view and bottom view.

Click on the Smart Support icon. Go to the Style dropdown and choose JEWEL MASTER GRY Master Pattern or JEWEL MASTER
GRY ProtoType, depending on the application. If these support types are not present, click on Import and select the support
style file from the file location.
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Figure 3. Ring view from bottom-up with Smart Support tool open

Go to the Analyze tab and click on Analyze Placement to view the default supports. This provides a good starting point; but
there are areas where you can remove points, and areas where you should add points to support this ring correctly.

Figure 4. Default support placement.

Go to the Modify tab to begin adding and removing support points as needed.

Tip: With the Modify tab open, click on the part to add a support point. Hold the CTRL key and click on a
support point to erase it.

Click on the View icon, scroll down to Clipping, and click on the box next to the Z. This activates the Z-Clipping plane. Click on the
Isometric view button. Select the blue-outlined plane and drag up. The ring will form as it will be during printing. Zoom in and
look at how details and features will be printed.
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Click on the Bottom view button, click on the gray clipping plane area, and pull up and down to expose more or less of the ring.

Add additional support points along the bottom of the ring, moving the clipping plane as you go.

Figure 5. Ring bottom view during the process of adding and removing support points.

Continue to move the z-clipping plane up and adjust the view to expose and remove unnecessary support points. Click Update
Supports to view supports. Click on Point to go back to adjusting support-point locations. Click on the Clipping Z box two more
times to remove the z-clipping plane.

Figure 6. Ring user view during the process of adding and removing support points. Final support design.

This ring can now be saved and exported with supports as an .STL file. When needed, it can be imported into a new print file
with the supports ready to go.

Wide Band Ring Supports

Rings with wide bands require more anchor points on the bottom half of the ring band. This will help maintain the roundness of
the ring.
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Figure 7. Wide-band and narrow-band rings.

The default anchor points on the ring band will not be enough to maintain the shape.

Note: Because manual support editing is necessary, 3D Sprint defaults to less supports so that removing
supports and adding supports is easier for the user.

Figure 8. Thick-band ring with default support points and manually added points.

Adjusting Cure Depth

The default cure depth provides a balance of resolving both positive and negative features. Some ring geometry may benefit
from adjusting the cure depth higher to focus on resolving fine positive features. Other ring geometry may benefit from
adjusting cure depth lower to focus on resolving fine negative features. Make adjustments up in cure depth in 10-20 µm
increments. Make adjustments down in cure depth in 5 µm increments. Click the Build Style icon and adjust cure depth for each
region layer.

Part Cleaning

Cleaning parts while still attached to the print platform reduces possible handling damage, and is faster than cleaning each
part individually. Use several cycles of rinsing with fresh IPA and blowing compressed air to dislodge print material to clean fine
features. Parts may need a final cleaning step after removing supports if spots of print material remain.
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Tip: IPA already dirty with JEWEL MASTER GRY material cleans slightly better than using only fresh IPA. Using a
two-step dirty IPA/clean IPA cleaning process works best.

Support Removal

Remove supports soon after cleaning. Once parts fully dry, support contacts are slightly stronger and may be more difficult to
remove. Use tweezers to remove side supports by gently pulling them away from the part.

Figure 9. Removing side supports on the print platform.

In some cases, it may be easier to remove the parts from the print platform prior to removing the supports. Use the punch tool
to detach parts from the print platform. Use tweezers to remove supports inside the part.

Figure 10. Removing side supports off the print platform and removing inside supports.

For thicker rings, pull gently up and at an angle to separate rings from the bottom supports.

For thinner parts, carefully insert tweezers under the part. Use tweezers to support the part and to apply upward pressure to
separate the part from the bottom supports. For delicate parts, work slowly, a little at a time, until the whole part is separated
from the supports.
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Figure 11. Using tweezers to support parts while separating from supports.

If parts are removed carefully, most of the support nibs should be projecting out of the surface. This is important because
positive support nibs can be sanded flush and leave no support scars.

Tip: Always post-cure parts before sanding support nibs flush. Parts are weaker than supports prior to post-
curing. After post-curing, parts and supports have equal strength and sanding gives the desired result.

Figure 12. Magnified image of positive support nibs on the bottom of a ring.

Frequency Asked Questions

1. My base layer failed to attach to the print platform. What
should I do?

Jewelry materials are formulated for extremely high detail
and require higher tolerances for the print platforms. Pour
the print material through a paint funnel filter back into the
bottle to remove any possible print debris that could cause
a problem. Clean the resin tray thoroughly, re-install, pour
the filtered material back into the resin tray, select a different
print platform and try the print again.
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1. My base layer printed, but my supports and ring failed to
print. What should I do?

1. If you choose to combine parts while generating supports,
this generates support base-trusses between parts, which
covers a lot of the holes in the print platform. If the holes
are covered, print material can't flow through the print
platform, which can result in support attachment failures.
Generate supports with all parts as separate objects to
allow free space between parts for fluid to flow through
the print platform.

2. If parts are set too close together, it can result in the same
issue as described above. Try providing additional space
between parts.

3. If problem still persists, try increasing the support cure
depth by intervals of 10µm.

1. My base layer and supports printed, but my part failed to
print. What should I do?

To achieve the best print quality of jewelry parts, it is better
to use many supports with very fine contacts than to use
fewer supports with large contacts. When supports print,
but parts fail to print, the first solution is to increase the
number of supports. Review the support contact points and
increase this density and try printing again. If supports are
very close together and parts are still failing to print, adjust
the support contact size by increasing the Pillar Top Ratio
slightly (increments of 0.05). Increasing the contact area will
increase the difficulty of removing rings from supports, but
should improve the printing reliability if this is a problem.

3.1.10 Figure 4 MED-AMB 10
Figure 4™ MED-AMB 10 is a translucent, rigid material with biocompatibility, designed to support a range of industrial and
medical applications. For biocompatibility information, please visit here .

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. To avoid chipping printed part during post processing, do not support part too close to its edges in 3D Sprint.
3. To avoid areas of color differences on your parts, space parts well in LC-3DPrint Box to avoid parts casting shadows on each

other.

Orientation

Please see Orientation section for TOUGH-GRY 10.

Fine Flat Tip Best for general use for fine, small parts up to large and large-cover parts.

Additional Tips & Tricks

Please see Additional Tips & Tricks section for TOUGH-GRY 10.

Post Processing Tips

1. General Best Practices apply.
2. To avoid chipping printed part during post processing, do not support part too close to its edges in 3D Sprint.
3. To avoid areas of color differences on your parts, space parts well in LC-3DPrint Box to avoid parts casting shadows on each

other.

3.1.11 Figure 4 MED-WHT 10
Figure 4™ MED-WHT 10 is a translucent, rigid material with biocompatibility, designed to support a range of industrial and
medical applications. For biocompatibility information, please visit here .

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. To avoid chipping printed part during post processing, do not support part too close to its edges in 3D Sprint.
3. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.
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CAUTION: Do NOT press down on the film when stirring.

4. Must keep clean bath of IPA to reduce color changing. Best to keep white material separate form other material to avoid
color contamination

5. White pigment is very difficult to clean off print platforms. Soak print platforms in solvent, and then wipe with solvent-
wetted towels.

Orientation

Please see Orientation section for TOUGH-GRY 10.

Fine Flat Tip Best for general use for fine small parts up to large and large-cover parts

Additional Tips & Tricks

Please see Additional Tips & Tricks section for TOUGH-GRY 10.

Post Processing Tips

1. General Best Practices apply.
2. Must keep clean bath of IPA to reduce color changing. Best to keep white material separate form other material to avoid

color contamination.
3. White pigment is very difficult to clean off print platforms. Soak print platforms in solvent, and then wipe with solvent-

wetted towels.

3.1.12 Figure 4 PRO-BLK 10
Figure 4™ PRO-BLK 10 is a production-grade additive manufacturing material with game-changing thermoplastic-like
mechanical properties, and environmental stability of mechanical and performance properties over time.

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. When printing thick parts or very dense platforms, use Premium Plus for best results. Note mode will be ~2x slower but can

provide very good part quality.

Orientation

Please see Orientation section for TOUGH-GRY 10.

Fine Flat Tip Best for general use for fine small parts up to large and large-cover parts.

General Flat Tip Best for large heavy-duty parts needing more robust tips. Check coverage before printing.

General Round Tip Best for Standard Thick build style, when reliability is a must such as tensile bars, and accuracy blocks.

3.1.13 Figure 4 RIGID GRAY
Figure 4® Rigid Gray - The balance of thermal and mechanical properties, combined with excellent print quality and long-term
Indoor and outdoor stability for prototyping and production.

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.

CAUTION: Do NOT press down on the film when stirring.

Orientation

Please see Orientation section for TOUGH-GRY 10.

Supports
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General Flat Tip

Best for general use for fine small parts up to large and large cover parts.

Fine Flat Tip

Best for large, thin parts or small fine feature parts. Check coverage before printing.

General Round Tip - Default

Best for Standard Thick build style, when reliability is a must, such as tensile bars and accuracy blocks

3.1.14 Figure 4 Rigid White
Figure 4® RIGID WHITE is an opaque rigid white production-grade plastic for same-day parts. This biocompatible-capable
materialprovides a smooth surface finish, long-term environmental stability, and long-lasting, clean white color.

Material Tips

1. Mix material gently in resin tray before each print.
2. Each morning before printing, roll the bottle for 20-minutes.

Accuracy Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. Place parts a minimum of 8mm apart to improve material flow and adhesion
3. If adhesion issues occur, raise the Base Layer Curing Time to 100sec. It may be necessary to also make Base Truss Infill Type

to 'Solid' rather than 'Connected Solid'.
4. If printing flat surfaces reduce the Interval Distance to 3-5mm to improve pillowing effect. Adding some supports will also

improve part.
5. When printing thick parts or very dense platforms, use Premium Plus for best results. Note - mode will be ~2x slower but can

provide very good part quality.

General Round Tip Supports

1. Best for general use for small parts up to large and large cover parts
2. When printing small fine parts in this material, the user may need to modify the Pillar Tip Ratio
3. Flat surfaces may need extra supports to prevent delamination.

Post Processing Tips

1. General Best Practices apply.
2. If parts have yellow after initial post cure part may need to be rotated and cured another 30 min.
3. If part are on platform it is best to try and hang parts upside down to post cure.
4. After sanding, if yellow discoloration occurs, cure in LC-3D for 30min to turn white

3.1.15 Figure 4 RUBBER-65A BLK
Figure 4™ RUBBER-65A BLK is a mid-tear strength, production-grade rubber combined with Shore 65A hardness and a high
elongation at break.

Accuracy Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. Remove parts from platform after printing. After 12 hours, large parts can detach from print platform and fall into material

tray.
3. Parts should be cleaned and cured soon after removing from the printer for best results.
4. Aged material may have a different color hue, but it does not affect part building or usage.
5. Parts work best if designed with a minimum wall thickness of greater than 2 mm.

Orientation

Orient parts at an angle to yield best results, rather than strictly on the x, y, or z axes.
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General Flat Tip Supports

Best for general use for fine small parts up to large and large cover parts

Fine Flat Tip Supports

Best for large flat surfaces. Editing will be required for parts with overhangs and multiple levels above the initial flat surface.

General Round Tip

Best for when reliability is a must, such as tensile bars and the blocks printed in the Accuracy Wizard .

3.1.16 Figure 4 RUBBER-BLK 10
Figure 4™ RUBBER-BLK 10 is a high-tear-strength material for production-hard, rubber-like parts with slow-rebound.

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. Material is soft when green. You must orient it in 3D Sprint to allow for the maximum number of support locations.
3. Tall parts (>100 mm) print best at 30 µm layer thickness.
4. Take care when handling green parts due to their flexible nature.
5. IPA does not dissolve this material. Propylene Carbonate must be used when cleaning printed parts. IPA should only be used

as a final rinse.
6. Parts can be sticky until post cured.

Orientation

Please see Orientation section for TOUGH-GRY 10.

General Round Tip

• Best for general use for small parts up to large and large-cover parts.
• When printing small, fine parts in this material, the user may need to modify the Pillar Tip Ratio.

Additional Tips & Tricks

Please see Additional Tips & Tricks section for TOUGH-GRY 10.

Post Processing Tips

1. General Best Practices apply.
2. IPA does not dissolve this material. Propylene Carbonate must be used when cleaning printed parts. IPA should only be used

as a final rinse.
3. Parts can be sticky until post cured.

3.1.17 Figure 4 TOUGH 60C WHITE
Figure 4® Tough 60C White - Versatile utilities with a good combination of impact strength, elongation, and tensile strength.
Long-term indoor and outdoor mechanical and color stability.

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.

CAUTION: Do NOT press down on the film when stirring.

3. Avoid printing parts flat. Orient parts for better flat surfaces.
4. When printing thick parts or very dense platforms, use Premium Plus for best results. Note mode will be ~2x slower but can

provide very good part quality.
5. For best results space parts at a minimum of 10mm apart.

Orientation

Please see Orientation section for TOUGH-GRY 10.
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Supports

General Flat Tip

Best for general use for fine small parts up to large and large cover parts

Fine Flat Tip

Best for large, thin parts or small fine feature parts. Check coverage before printing.

General Round Tip - Default

Best for Standard Thick build style, when reliability is a must, such as tensile bars and accuracy blocks

3.1.18 Figure 4 TOUGH 65C BLACK
Figure 4® TOUGH 65C BLACK - Versatile utilities with a good combination of impact strength, elongation, and tensile strength.
Long-term Indoor and Outdoor environmental stability.

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference .
2. Avoid printing parts flat. Orient parts for better flat surfaces.
3. Parts, before and after cure can be easily scratched and show up on part surfaces.
4. When printing thick parts or very dense platforms, use Premium Plus for best results. Note mode will be ~2x slower but can

provide very good part quality.
5. For best results space parts at a minimum of 10mm apart.

Orientation

Please see Orientation section for TOUGH-GRY 10.

Supports

General Flat Tip

Best for general use for fine small parts up to large and large cover parts.

Fine Flat Tip

Best for large, thin parts or small fine feature parts. Check coverage before printing.

General Round Tip - Default

Best for Standard Thick build style, when reliability is a must, such as tensile bars and accuracy blocks

3.1.19 Figure 4 TOUGH-BLK 20
Figure 4™ TOUGH-BLK 20 is a rigid, black plastic with industry-leading UV stability. It is ideal for high-performance, functional
prototyping applications.

General Tips

General best practices apply, as seen in the Figure 4 Print Material Quick Reference .

Orientation

Please see Orientation section for TOUGH-GRY 10.

General Flat Tip Supports

Please see General Flat Tip Supports section for TOUGH-GRY 10.

• Best for large, heavy duty parts needing more robust tips. Check coverage before printing.
• General Round Tip Supports - Best for Standard Thick build style, when reliability is a must, such as tensile bars and accuracy

blocks.
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Fine Flat Tip Supports

Please see Fine Flat Tip Supports section for TOUGH-GRY 10.

Best for general use for fine small parts up to large and large cover parts.

Additional Tips & Tricks

Please see Additional Tips & Tricks section for TOUGH-GRY 10.

3.1.20 Figure 4 TOUGH-GRY 10
Figure 4™ TOUGH-GRY 10 is capable of print speeds up to 100 mm/hour in a strong production plastic. With 25% elongation
at break, it has the durability required for a broad range of applications. This dark gray plastic material is extremely stable,
including under high humidity conditions. If you are reading this online, you can use the quick links below to skip to a section.

General Tips

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference.
2. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.

CAUTION: Do NOT press down on the film when stirring.

Orientation

Part orientation is the first critical setup function before slicing a part in 3D Sprint™. The part orientation must consider several
features before adding supports to the part. The optimal orientation may not be intuitive at first, but the orientation is based
on the premise of printing on a 3D printer one layer at a time. The goal of this document is to allow the customer to build that
orientation skill and intuition.

Tip 1 - Identify No Support Surfaces-

The first thing to consider for a part is to determine what surfaces or features should NOT have a support. Note in 3D
Sprint™for Figure 4™, this will be surfaces facing AWAY from the print platform or 'floor' (checker board plane in the illustration
below) of 3D Sprint™. Thus, surfaces such as datums, textured surfaces, and outer cover surfaces should be oriented for no
supports.

Figure 1. Initial part orientation in 3D Sprint™

Tip 2 - Large Cross Sectional Area

To get the best surface quality and accurate part, minimizing the cross sectional area is very important. Use the Transform
function in 3D Sprint™to rotate the part such that it satisfies Tip 1 and Tip 2.

Note: It is also useful to use the View window to click on the Top Left triangle of Z in the Clipping section. This
will create a plan that can be moved up and down in Z to view the slice image of the layer being printed. In
other words, what is seen in Red is what is being printed in that layer.
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Figure 2. Initial part orientation and View window in 3D Sprint™

Figure 3. Cross section area view in XY plane using Z-axis clipping in View. Red denotes the layer information.

To see the large cross sectional area for this part, move the blue plane down. This is a large cross section that would be better
printed in an angular rotated orientation. Note a Large Cross Section can be considered to be a cross section that is greater
than a 20x10mm or 8x30mm area. This should be defined as being in a local area and not the full area of the layer. The figure
shows an area that has four large cross sectional local areas.
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Figure 4. Large cross sectional area. Shows four sides with approximate 10x30mm cross sectional areas.

Continue to move the blue plane up and down along the Z-axis to identify the large cross section areas in the part. The area
below shows a part that is approximately 8x35mm in two local areas.

Figure 5. Large cross sectional area. Shows two areas with approximate 8x35mm cross sectional areas.

Tip 3 - Critical Feature Orientation

A critical feature is a feature for which you would prefer minimal or no supports, such as a screw boss, snap, or other critical
geometry. On the part in this example, there is a screw boss on one side of the part. For these features, it is optimal to rotate
the part so they are facing away from the print platform. Note these surfaces may have minimal supports (minimal meaning
<5), but not in such a way the support interferes with the critical function of the feature. Note manual editing may also be
required on these features.

Enable Tip 1, Tip 2, and Tip 3 - Once considering the items described in Tips 1-3, the part can be oriented. The Transform
window in 3D Sprint™ can be used to orient the part back 45-degrees toward the Y-axis. Note the change in cross section being
printed on this layer compared to the orientation in Figure 5. The following images show the considerations from Tip 1-3.
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Figure 6. Re-oriented part after following Tip 1 for no support surface.

Figure 7. Re-oriented part after following Tip 2 for small cross sectional area.

Figure 8. Re-oriented part after following Tip 3 for feature location.

Tip 4 - Minimizing Supports Using Self Supporting Orientation

Orienting to allow sections of the part to be self supporting should be the next consideration before adding supports. This
will include orienting the part to allow the larger sections of the part to be at approximately 45-degrees relative to the print
platform. An example of this is to move edges of the geometry that are parallel to the print platform, to be at an angle.
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Figure 9. Top of center hole is parallel to the print platform.

Figure 10. Top of center hole is now at a self supporting angle to the print platform.

The part in the image below is now ready to add supports. It has used the following information to optimally orient the part:

Tip 1 - Identify No Support Surfaces - Cover area has been considered and no supports are on top surfaces of the part. There is
minimal supports on the side of the outer surface wall.

Tip 2 - Large Cross Sectional Area - The large cross sectional areas were identified and have been optimized.

Tip 3 - Critical Feature Orientation - The critical features of the large holes and screw boss have been oriented for minimal
supports.

Tip 4 - Minimizing Supports Using Self Supporting Orientation - The final orientation moves the part such that it minimized
edges parallel to the print platform.
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Figure 11. Final orientation after following Tips 1-4.

General Flat Tip Supports

The General Flat Tip supports are a support option for TOUGH-GRY 10 and TOUGH-GRY 15 materials. These supports are
generated by selecting General Flat Tip in the drop down menu of the Smart Support Window. The General Flat Tip supports are
used as Default supports for the aforementioned materials.

Figure 12. Drop down menu for General Flat Tip supports.

The General Flat Tip supports have a plus sign cross section leading from the print plate to the support tip. Then the support tip
is rectangular or in appearance 'Flat'. This allows for a small scar on the part and easy cleanup for post process.
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Figure 13. Image General Flat Tip supports

Some tips for using these are as follows:

1. Use for general purpose printing, and good for parts with fine detail or small features.
2. To make the supports thicker go to Pillar and make the Chunk Pillar Width larger by 0.05mm.
3. To make the supports thinner and easier to remove, go to Pillar and make the Chunk Pillar Width smaller by 0.05mm.

Figure 14. Chunk Pillar Width parameter under Pillar selection.

Note that smaller supports may break during printing for large thick parts or higher warp geometries.

3D Systems, Inc. 55 p/n 42-D113, Rev. N



Figure 15. Fully supported part using General Flat Tip supports.

1. To thin the support tip only, go to the Pillar Top Height under Tip, and increase the value to 2mm or make larger by 0.5mm
increments.

Figure 16. Pillar Top Height parameter under Tip selection.
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Figure 17. Image on left shows standard General Flat Tip support tip. The image on the right shows adjusted tip to 2mm
height.

1. It may be optimal to make the supports very thin for very fine detail and/or small parts. In this case, to make the supports
thinner and easier to remove, go to Tip and make the Pillar Top Height larger by 0.1mm AND make the Chunk Pillar Width
smaller. In the figure below, the Chunk Pillar Width is also set to 0.3mm.

Figure 18. The General Flat Tip support tip AND pillar are very thin.

Fine Flat Tip Supports

The Fine Flat Tip supports are a support option for TOUGH-GRY 10 and TOUGH-GRY 15 materials. These supports are generated
by selecting Fine Flat Tip in the drop down menu of the Smart Support Window. The Fine Flat Tip supports are used as special
case parts that require many supports on the print plate facing surfaces, many small features, or thin cover parts.
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Figure 19. Drop down menu for Fine Flat Tip supports.

The Fine Flat Tip supports have a plus sign cross section leading from the print plate to the support tip. Then the support tip
is rectangular or in appearance 'Flat'. This allows for a small scar on the part and easy cleanup for post process. The density of
supports on a part will be much larger than that for General Flat Tip supports. The part shown in Figure 20 is a great candidate
for Fine Flat Tip supports as it is going to need the extra support at the base due to the nature of the following:

• Radius attach point at bottom of part
• Keep mating part features on upward facing surfaces to minimize supports
• Maintain geometry on the flat section on the support side of the part. Too few supports require more sanding.

Figure 20. Part geometry that requires Fine Flat Tip supports
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Figure 21. Fully supported part using Fine Flat Tip supports.

The Fine Flat Tip supports will have a much higher density than normally seen in other support types. This is because the
intent is to cover a large surface that cannot be reoriented to optimize. The larger amount of supports allow for much smaller
supports tips while still maintaining build reliability. Take caution to zoom in on the part to get a real look at how big the
support is going to be. The anchor points scale in 3D Sprint™ for the user to see the location but size can be deceiving.

Figure 22. Fine Flat Tip anchor points with window zoomed in and out for comparison.

Some larger parts get over supported due to the conservative nature of the support style used to handle a larger collection of
geometries. Some of these supports can be deleted using the Modify/Erase Function on the Smart Support tabs.
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Figure 23. Erase location in Modify tab.

The user will have to determine how many supports can be removed from the part. Most parts building at >45-degree angle
can print self-supporting with only few supports needed. This will make cleaning the support tips left on the part after printing
much easier.

Figure 24. Over supported part is on the left. The modified part is the image on the right.

3D Systems, Inc. 60 p/n 42-D113, Rev. N



Fine Flat Tip supports are dependent on the angle set in the parameters. This can be changed by the user and will be explained
later in this document. However, the default is at 50-degree angle. Thus all flat surfaces <50-degrees will get supports. This can
also cause over supporting edges that do not need supports. This is shown in Figure 25.

Figure 25. Over supported part is on the left. The modified part is the image on the right.

Some tips for using these are as follows:

1. Use for general purpose printing, and good for large cover parts, flat parts, fine detail or small features.
2. Supports can be resized using Chunk Pillar Width and Pillar Top Height as described in the General Flat Tip section.

Additional Tips & Tricks

Because the TOUGH-GRY 10 and TOUGH-GRY 15 are general purpose materials, there are infinite organic shapes that can be
presented for supports. No support type all portions of every imaginable geometry, which is why the 3D Sprint™ supports types
presented here are setup conservatively. Meaning most parts will get more supports than needed to print a great part. This will
mean more tips & tricks are needed to catch anomalies and the 3D Sprint™ software also allows for tools to fix these anomalies.

Part Geometry Requiring Extra Support Modification

Part geometries in this instance are defined as areas of the part or features that do NOT get supported correctly. This normally
occurs on corners and large radii edges. In addition, some over supported features that need may cause part defects will need
supports removed.

The images in Figure 26 show the added supports to make this a more successful print. This part had been setup with auto
generated Fine Flat Tip supports.
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Figure 26. Default Fine Flat Tip anchor points are on the left. Note the image on the right side has supports added to the
radius edge circled in RED.

Another place to always check in a part is holes. A hole >3mm should have at least a single support inside the top edge. More
supports would be determined by the length of the 'tube' the hole is in. The images in Figure 27 show the added support in the
top of the hole. Note this is part is only 2.5mm thick and only needs one support to guarantee a circular hole.

Figure 27. Default Fine Flat Tip anchor points are on the left where the hole has no supports. The image on the right side has
one support added to the top inside edge of the hole.

Some parts have a lip along the bottom edge of the part. To insure the lip is printed flat and not wavy, the Fine Flat Tip supports
are used. It is good to verify the supports are even along the edge. This may require deleting some supports as well as adding
others.
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Figure 28. Default Fine Flat Tip anchor points are shown in the top image. Both the inner and outer edge show uneven
supports. The bottom image shows the modified anchor points to give an even distribution of anchor points along each edge.

Tools for Modifying Supports

3D Sprint™ has many tools available, so advanced users may modify the supports to better fit the part geometry. These are
shown in the Smart Support window under each appropriate Tab and Support Item. The tools described in this section are most
commonly used tools when building parts.

The Analyze tab shows Common Acquisition Parameters, which define the support node placement on the part. These also
define support density on the given geometry.

Figure 29. The Analyze parameters available to the user in 3D Sprint™.

The most commonly used parameters to determine placement on the Analyze tab are the Sharp Edge Point Interval and Thin
Wall Point Interval. These control the density of the supports on the sharp edges of the part and large flat surfaces respectively.
Note 'thin wall' in this definition is part thickness in XYZ direction, it is not just a vertical wall.

The Sharp Edge Point Interval determines the spacing of the anchor points along a sharp edge. Thus, if a part is more vertical it
can use spacing at up to 10mm. However, for sharper edges or on curved edges it may need to be as low as 3mm.

Figure 30. The images show the straight edge and curve edge spacing based on the Sharp Edge Point Interval value. From the
top down the Sharp Edge Point Interval values equal 3, 5, and 10.

The Thin Wall Point Interval determines the spacing between the anchor points on the grid used for thin wall non-flat surfaces.
(Note flat surface support node spacing is determined using the Point Influence Radius parameter). Another dependency for
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the Thin Wall Point Interval is the Thin Wall Thickness. The Thin Wall Thickness is the wall thickness of the surface whether it is
angled or curved. The default Thin Wall Thickness = 4.

Figure 31. The images show the grid spacing based on the Thin Wall Point Interval value. From the top down the Thin Wall
Point Interval values equal 2.5, 5, and 10.

More detail on the support parameters is available by clicking on the Help icon in the Smart Support window. In addition, Best
Practices videos are available by clicking on the Best Practices link in the Smart Support window.

3D Systems, Inc. 64 p/n 42-D113, Rev. N



Figure 32. The Help icon and Best Practices link can be found in the Smart Support window.

3.1.21 Figure 4 TOUGH-GRY 15
Figure 4™ TOUGH-GRY 15 is designed to offer high strength and stability for production applications. Economical pricing allows
short run production parts to be produced at a fraction of the cost of traditional methods. With 35% elongation at break,
this durable opaque gray material produces highly accurate components for consumer goods, aerospace and automotive
industries, with digital molding productivity and cost-efficiency.

Accuracy Tips

In order to achieve good accuracy with TOUGH-GRY 15, it is important to follow the part setup instructions below for orientation
and supports. Some other key tips are as follows:

1. General best practices apply, as seen in the Figure 4 Print Material Quick Reference.
2. For best results use the Resin Mixer to gently stir between prints and after the resin has been sitting overnight.

CAUTION: Do NOT press down on the film when stirring.

Orientation

Please see Orientation section for TOUGH-GRY 10.

General Flat Tip Supports

Please see General Flat Tip Supports section for TOUGH-GRY 10.

• Best for general use for fine small parts up to large and large-cover parts.
• General Round Tip - Best for Standard Thick build style, when reliability is a must, such as tensile bars and accuracy blocks.

Fine Flat Tip Supports

Please see Fine Flat Tip Supports section for TOUGH-GRY 10.

Best for large thin parts or small fine feature parts. Check coverage before printing.
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Additional Tips & Tricks

Please see Additional Tips & Tricks section for TOUGH-GRY 10.

3.1.22 Figure 4 Rigid 140C Black
Figure 4® Rigid 140C Black is a high performance material, delivering production-grade parts with long-term mechanical
stability in various environments. Suitable for housings, casings, and all types of prototyping or production components. Ideal
for automotive under-the-hood and internal cabin end-use clips, covers, connectors, housings & fasteners, electrical latching,
and board connectors.

Material Tips

1. Material is a two-part epoxy/acrylate hybrid with an A&B part that must be mixed at 19:1 ratio
2. Mix new amount for each print unless in the SAME day
3. Material Amount = Part Est+100g+(Est*15%)
4. May need to add 20% rather than 15% pending the density of print or part

3D Sprint Tips

1. General Best Practices apply
2. Default layer thickness for accuracy is at 30um layer thickness.
3. Orient small holes (0.5-1mm) parallel to the plate when possible.
4. For best results space parts at a minimum of 10mm apart.

3D Sprint Supports

General Round Tip - DEFAULT Best for Standard Thick build style, when reliability is a must such as tensile bars, and accuracy
blocks

Post-Processing Tips

1. General Best Practices apply
2. Manual clean ONLY, do not use sonication
3. Wear wet gloves when handling parts to prevent smudges
4. Due to the lack of sonication, a soft bristled brush and/or IPA squirt bottle may be required to clear small crevices of

uncured resin.
5. Note Thermal post cure at 3min ramp rate to 130C and 3-hour steady cure
6. Allow parts to cool to room temperature before handling
7. Rinse with water - If TPM is not rinsed with water, the part may get blue/white marks on the sidewalls.
8. IPA Clean - To prevent degrading the elongation-at-break properties, do NOT exceed recommended time in IPA (1-2

minutes).
9. Thermal post cure requires a three-hour hold at 130°C to fully cure the parts. Do not exceed three hours for post curing.

3.2 Figure 4 Standalone Best Practices Stacked Printing Workflow
Industrial Stacked Printing is a semi-automated workflow to create, stack, support and print multiple copies of a single part.
You will still need to manually place struts (our new support feature); but we have simplified the process so that only a few
struts need to be added manually. The rest will be replicated automatically. The different sections in this guide will provide
instructions and best practices for the Stacked Printing Workflow.

3.2.1 General Tips
• Before beginning stacked printing, you may wish to complete our Figure 4 training videos for 3D Sprint fundamentals .

General best practices apply to stacked printing.
• See the FAQ section if you are experiencing software or printing errors.
• The most important factor to ensure successful prints is placing supports/struts correctly.
• Make sure to practice preventative maintenance to ensure consistent and optimal print.

• Check the catch-tray glass inside the printer often and clean as needed.
• Check for part debris once in a while or after failed prints, and run resin tray cleaning jobs. Follow the instructions in the

User Guide to run a resin tray cleaning.
• Pour unused print material through an automotive funnel to remove any print debris and to keep material in optimal

condition. Follow the recommendations here for funnel usage.
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• Take note that dense stacked prints might require more material than the resin tray can hold. You might need to reduce
stack height or reduce the stack density.

• If you also have a Figure 4 Modular printer, and want to print the same build on both machines:

• Select Modular as your printer and set up the stack.
• To create the Standalone version, change the printer to Standalone within the build file, and then double-lasso select any

rows of the stack that are highlighted red. Make sure to select the stack rows twice, as the first selection will select the
whole stack, rather than the red parts.

3.2.2 Build Setup
Before beginning stacked printing, you may wish to complete our Figure 4 training videos for 3D Sprint fundamentals.

To set up stacked builds:

1. Import the file to be stacked.

Note: You can stack a pair/set of parts either
separately or together. If stacking together,
the parts will need to be combined before
proceeding (see image at right).

Note: It is also possible to stack parts
separately and have them placed within the
same platform.

Note: If you also have a Figure 4 Modular
printer, and want to print the same build
on both machines - Select Modular as your
printer and set up the stack. To create the
Standalone version, change the printer to
Standalone within the build file, and then
double-lasso select any rows of the stack that
are highlighted red. Make sure to select the
stack rows twice, as the first selection will
select the whole stack, rather than the red
parts.

1. Determine the optimal orientation for nesting and
supporting. Here are some guidelines to keep in mind:

1. View these training videos for basic orientation tips.
2. Determine critical features to which you want to avoid

adding supports.
3. Determine how to nest your parts efficiently, especially if

you have a set of parts.
4. Avoid printing large cross-sections and large flat parts. Try

to re-orient at an angle.
5. Avoid printing parts that have trapped volumes. Parts will

act like a suction cup on the membrane, causing print
failures and delamination. If you cannot avoid trapped
volumes, adding vent holes, adding more cross-beam
struts for rigidity during printing or slowing down the
print with premium build styles might help mitigate print
defects and failures.
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1. If you are adding as base to your stack, import your STL for
that base now.

a. 3D Sprint has some base templates embedded within
the application.

1. C or D:\Program Files\3D Systems\3D
Sprint\Resources\Printers\Figure 4\Bases

2. The link shortcut can be found in 3D Sprint.
b. Bases are recommended because they allow you to:

1. Punch out the stack as a whole when doing post
processing

2. Hold your stack by the base when handling and
cleaning it

3. Stand up your stack for drying and curing (if parts
are not packed too densely)

3.2.3 Stack Setup

Create Stack

There are two ways stacks can be arranged: Regular and Staggered. For either method, begin by selecting the part and clicking
the

button. Bases are recommended when creating any stack.

Regular

In this method, you will input X, Y, and Z counts for an array of stacked parts.

1. Each part/combined set of parts acts as a cell of an array
of parts that will duplicate struts and supports. Inputting a
Count value will add that number of cells on the X, Y, or Z
axis.

2. Distance values indicate the distance between the centers
of the parts.
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1. Use the Count and Distance inputs to create your stack.

a. The image at the right shows a sample array of cells
(dots). Notice that the stack preview shows your initial
part/cell with its neighboring parts in X, Y and Z. Use
the models in this preview to assist in visually nesting
the parts.

b. You can also drag each neighbor part to a desired
location instead of adjusting distance values.

c. The blue dots indicate that the stacked parts will fit
within the build area, while the red dots indicate they
will not fit.

d. Start off with a large value in Z Count as the stack
will automatically ignore any part/cell that have a red
dot. Then change the Z Count value to the required
number.

e. Input large values for X and Y Count past the platform
and then go to Top View.

f. Drag parts around until you get a desired nesting.

Array demonstrating stacked capacity on a Figure 4

1. Click on Set Base, and then select the base file that was
brought in earlier during build setup.

Note: This base will be printed directly on
the print platform.

Note: The base will scale to the size of the XY
part boundary, not to the whole platform.

a. The Margin field indicates the distance between the
boundary of the part and the edge of the base.

1. A margin of 0 mm means that the base is the size
of the part boundary. The larger the margin is, the
smaller the base is.

b. The Clearance field indicates the distance between the
bottom of the first-row parts and the base.

2. Click on Set to apply the Stack generation.

a. An I-beam like connector piece will connect between
the centroids of each part/base.

1. Notches are created in the middle of each base
connector piece in case you would like to break
up your stack pre- and post-curing in order to post-
process parts according to your preferences.

2. Base connectors do not extend into the base itself.
3. You can use struts from the base to the part

to create a more-rigid structure; but the struts
connected to the base will not be replicated with
each cell.

3. If any changes need to be made to the stack generation,
such as spacing between parts, click on the stack and click
on Create Stack to edit.

Note: When you re-edit a stack, any struts made
on the stack will be erased.

Staggering

In this method, you will still input X, Y, and Z counts for an array of stacked parts (Steps 1-3 in the Regular section, above).
However, when you click Stagger, the parts will shift every other row.
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1. In the example at the right, the second row shifted half the
distance between two of the parts in the X-direction. For
some geometries, this makes it easier to nest parts more
closely.

2. Useful for medium-sized parts that are larger than 35 mm
(in the Y-direction). Otherwise, you would only be able to
create a stack in the X-direction

3. This feature can help you when cleaning printed stacks
because the spacing in between parts allows for better
flow for cleaning solvents to pass through.

Base

In this method, you will follow either the Regular or Staggering workflow; and you will add in a custom STL file that can be used
as a base on which to stack your parts. This base will be printed directly on the print platform without supports.

1. Click the Set Base button and select the STL file that was
initially imported during build setup, or select one of the
pre-installed 3D Sprint templates.

2. The Margin field indicates the distance between the
boundary of the part and the edge of the base.

a. A margin of 0 mm means that the base is the size of the
part boundary. The larger the margin is, the smaller the
base is.

b. Avoid having the bases intersect.
3. The Clearance field indicates the distance between the

bottom of the first-row parts and the base.
4. An I-beam like connector piece will connect between the

centroids of each part/base.

a. Notches are created in the middle of each base
connector piece in case you would like to break up your
stack before or after curing in order to post-process
parts your way.

b. Base connectors do not extend into the base itself.
c. You can use struts from the base to the part to create

a more-rigid structure; but the struts connected to the
base will not be replicated with each cell.

Notch in between base connector pieces

3.2.4 Support Generation
There are three workflows to create a stack: Manual, Semi-Automatic, and Critical Features
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Manual (Struts + Base) This creates custom, high-level support
struts to reduce support volume usage, improve cleaning
of parts as a whole stack, and control support placement/
scarring. However, this might require more trial and error
when you are first starting off.

Semi-Automatic (Supports + Struts) This uses 3D Sprint's
Smart Support function to auto-generate supports and add
cross-stack struts for added rigidity during printing.

Critical Features - This is similar to Semi-Auto support
generation, but uses several support tools like regions or
cylinders to avoid supporting textured surfaces and critical
features that would otherwise get supported during stacking.

3.2.4.1 Manual Support Generation

This manual process will allow you to generate struts as supports and as cross-bracing in place of auto-generated supports. Use
the following guidelines when doing this:

1. Review strut creation here . Learn the workflow and the shortcuts for creating struts.

a. Use default settings for optimal support removal and stiffness. Parameters are open for you to change when optimizing
your stacked print.
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b. Adjust Normal should be on to make support tips normal to the surface. This prevents supports intersecting a surface at
an off angle, which would create larger cross-sections than desired when removing supports.

2. Click on View on the top right, and check the Down Face box under Shading. This allows a color visualization of down-facing
regions to avoid under-supporting when manually creating your supports.

3. Start between the first and second row of parts when creating your struts. Use ctrl + Click and select two points to generate
your strut.

a. You can create struts on or between struts.
b. Check that the angles of the struts are self-supporting. To be safe, 40°-90° from the horizontal should be fairly self-

supporting; otherwise, use a strut for support.
c. With down-face visualization on, you can generate struts to support the down-facing regions and any initial layers of a

part.
4. When struts are created, that strut will be replicated across the entire array.

1. Repeat these steps until your parts are fully supported.

a. When creating struts on the bottom facing regions of
parts:

1. Go to the VIEW module on the top right of 3D
Sprint.

2. Go to Clipping section and click on Z-Axis Clip once.
When using clipping tools, turn off outline if your
stack has a lot of parts.

3. Drag the Z-Clip plane upwards until you see a thin
section of the bottom face surface you want to
support on the second row of parts.

1. Looking at a downward angle like the image at the right,
hold down CTRL and click on a point on the clipped bottom
surface and then another point on an existing strut on the
top surface of the first row of parts.

3.2.4.2 Semi-Auto Support Generation

This process will create auto-generated supports, in addition to support struts you have already created.

1. Create struts for cross-bracing between each stack/column
after stack is created.

2. Click Smart Support, go to the Generate tab, and click
Create Supports.

3. Go to the Analyze tab to view support-point placements.
4. If you wish to only create smart supports for the bottom

layer of the stack, or to ignore struts when creating
supports, expand the Stacking section and check Bottom
Stack Layer Only.
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1. Support points created with Smart Support are also
replicated across a stacked print for each cell. However,
supports aren't necessarily the same. These support points
can be modified in the Modify tab using several features.

a. Group Edit - This drop down provides different options
for adding/removing support points, to be replicated by
their respective cells.

1. All - This selection makes any support modification
affect all cells equally.

2. Later B/NB - "B" is the bottom layer. "NB" is
everything except the bottom layer. This selection
allows for different support strategies for supports
that go from the base or first row of parts to the
print platform, versus those that go between parts.

3. Layer - This selection allows for control of support-
point modification on a specific part layer.

4. Part - This selection allows you to edit specific part/
cell supports without affecting other parts.

3.2.4.3 Supporting Textured Surfaces

Heavily textured parts are not the best for industrial stacked printing, as textures create larger file sizes. Large file sizes multiply
heavily, especially when stacking is an option. Support generation, support region tools and print files will take a while to
generate. If stacking is still desired, use these guidelines:

1. Generate struts for cross-bracing, if necessary.
2. Go to Smart Support > Modify > Region.

a. Click Texture > Auto Detect.
b. Click the [-] minus button in the modification mode and select the green space on the texture.
c. Supports will not be placed in red regions, only green regions.
d. Click Update Supports.

3. Another method to stack parts with textured surfaces can be found in the advanced stacking techniques section.
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3.2.4.4 Advanced Stack Support Techniques

1. You may need to use advanced stack-support techniques:

a. When the top of a part has a lot of critical features
b. The part has a large central hole or space
c. When your assembly looks like the one at the right
d. When you wish to minimize support scarring
e. When your part has textures, such as in the image at

the right

1. Determine how you will nest the parts in the z-axis:

• Go to Copy, check Linear Pattern, and adjust the count
and distance.

• Record the distance that you select.
• When considering processing and post-processing

workflows, leave space in between parts for solvents
and light to reach the parts. This would be difficult
when using smart supports.

2. Create a 5 mm diameter cylinder in Generate Geometry.

• Make the height of the cylinder the same as the
spacing between the parts in the z axis, the distance
in z.

• You can also create a larger cylinder or make it a
tube/thin-wall cylinder by Boolean subtracting it with
a smaller cylinder.

• Multiple cylinders can help with rigidity of the whole
structure.

3. Raise your part a couple of millimeters so that there is
enough space to create struts branching from the cylinder.

4. Combine the cylinder and the part.
5. Create Stack, using a base and the spacing distance you

recorded earlier.

a. Make sure that clearance is -0.5 mm or -1 mm to
ensure that the cylinder will intersect with the base.

6. Create strut supports stemming from the main cylinder to
prevent struts on critical features or on textures

In the image above, a cell/set of parts is hidden to show
an individual cell and its strut connections more clearly. The
top part has all the struts within a cell- that way, parts will
get replicated equally throughout the stack. Additional struts
can be made between two cells and will get automatically
generated from the first row to the base.

3D Systems, Inc. 74 p/n 42-D113, Rev. N



3.2.5 Create Struts
Create struts using a point-to-point selection. Struts can be created outside of stacking if applied within a single part. The
following keyboard shortcuts will be useful when creating struts:

ctrl+click Prevents selection of existing strut points. Also creates a strut
on an existing strut.

spacebar Apply strut (set button)

delete/backspace Delete selected strut

C Clear struts selection

A Select all (useful for modifying parameters on all struts)

ctrl+Z/Ctrl+Y undo/redo

Creating Struts Workflow for Industrial Stacked Printing

1. In the Print module, click Create Struts.
2. Change options and parameters as desired.
3. Click on two points between the first and second row of

parts to create a new strut between them.

Note: Once two points are defined on a model,
the preview of a strut appears. You can edit the
previewed strut by clicking and dragging one of
the end points of the strut or by clicking on a
new position.

1. Press the Spacebar or click Apply to create a strut on the model. You can now add a strut using one of the following
methods:

a. Click two points on a model.
b. Click a point on an existing strut, and then click a point on the model.
c. Click points between two existing struts.
d. Click two points between two different parts (only available in stacked printing).
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1. Use Ctrl + Click to set the start point of a new strut on the
existing strut, and then click on a point on the part.

1. Press the Spacebar or click Apply to add a new strut.

a. If necessary, you can delete the created strut by
clicking or lasso-dragging and pressing the DEL key.

b. The committed struts are used as auxiliary components
of the model, similar to supports.

2. Repeat until parts are adequately supported.

Criteria for Adding Struts

1. Add struts between the first and second row of parts.

a. To reduce material usage, make use of creating struts
off other struts like a tree branch.

b. Keep an eye on your struts and make sure they are
self-supporting. If they are close to horizontal, make
sure they have additional struts connected to it to make
sure it prints.

c. Make sure that struts do not accidentally intersect your
part.
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1. Add struts within parts

a. Take note of your critical features. With struts, support
scarring is minimal and normal to surface.

b. If Down Face coloring is turned on (40° angle and 10
grades), you can determine what sections of a part
might need some struts in order to print.

c. You can use the Z-Clipping tool and drag it across the
part to check for islands that will need supports. Make
sure to add struts to those islands.

1. Add struts between columns.

a. Make use of triangular geometry to stiffen up strut
structures.

Tips

1. Use default settings for optimal strength and minimal
support scarring. Edit parameters for optimization in a
production setting.

2. Strut parameters may need to be adjusted for certain
materials. Softer materials might need more struts.

3. Can reduce strut width or add a center taper to use less
material.

1. When creating struts, it is helpful to create trusses with
the struts to add rigidity to a structure for cleaning
and handling during post-processing. Triangles are very
helpful; and it is good to check that the angle of the struts
are self-supporting - 40-90° from the horizontal should be
fairly self-supporting. Check down face under Shading in
the View tab.

• You cannot create struts between two bases.
• You cannot create struts between the first row of part

and a base that is not directly below a column/part.

Parameters

In 3D Sprint, click the ? button in the Create Struts dialog to see complete information about strut functionality.
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3.2.6 Printing and Post-Processing

Printing

When submitting your stacked build, keep in mind that the slicing operation performed by the machine might take longer than
normal due to the large file sizes from the stacked parts.

Material Notes

1. HI-TEMP 300 - You cannot create high-density prints with this material.
2. JEWEL MASTER GRY - Use the 50 µm Prototyping Build Style.

Post Processing

Note: Use the appropriate cleaning solvents for your material, as per the Post-Processing instructions .

There are two ways to clear a stack of parts:

• Clean the whole stack as one - This reduces defects from handling. The following instructions will apply to this method.
• Take apart the stack and clean the parts independently, using your regular post-processing methods.

Clean the whole stack as one

The benefits of this method are:

• Reduces rubbing parts
• Can work with automation

Procedure

1. Remove job from the printer.
2. Punch out base with stack or keep the stack on the platform.
3. Use compressed air to lightly break the surface tension on the stack.
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4. Pay attention to holes in parts and trapped volumes.
5. There are two recommended methods for cleaning stacked parts:

a. Agitation through dunking: 

1. Fill up two large baths of IPA.
2. Keep in mind that your bath must be at least 124 x 70 x 225 mm with the print platform attached. If the print platform

is not attached, the bath must be at least 124 x 70 x 195 mm.
3. Use one bath for initial cleaning, dunking the stacked print for at least one minute.
4. Use compressed air to dry the stack and see where uncured material still exists.
5. Dunk the stack again for another two minutes.
6. Use compressed air again to blow-dry the stack.
7. Then use a clean spray bottle of IPA and spray the stack.
8. Blow-dry with compressed air and inspect the stack for uncured material.

b. Ultrasonic 

1. Keep in mind that your ultrasonic chamber must be at least 124 x 70 x 225 mm with the print platform attached. If the
print platform is not attached, the chamber must be at least 124 x 70 x 195 mm.

2. Fill the chamber with >91% IPA.
3. Place the stack in the ultrasonic bath for three minutes
4. Use compressed air to blow-dry the stack and break the surface tension of any print material still on the parts.
5. Place the stack into the ultrasonic cleaner for another three minutes.
6. Use compressed air to blow-dry the stack.
7. If still not cleaned, use a spray bottle of IPA, or carefully use IPA and a brush.

6. Leave the stacked parts out to dry for at least 90 minutes, OR place the parts in an oven for 25 minutes at 35°C (95°F).
7. Cure the parts in the NextDent LC-3DPrint Box for the time specified in the User Guide .

Clean parts individually

The method is not recommended, as it defeats the purpose of stacking parts, unless the parts are really large and complicated.
This method might be recommended if your stack did not have enough spacing between parts for UV light to reach certain
surfaces during post curing.

Procedure

1. Remove job from the printer and punch out the stack.
2. Pull parts away from the stack according to your preferences.
3. Place individual parts into an ultrasonic bath for three minutes, and then remove.
4. Blow-dry parts with compressed air and inspect for residual print material.
5. Place parts into an ultrasonic bath for another three minutes.
6. Leave the parts out to dry for at least 90 minutes, OR place the parts in an oven for 25 minutes at 35°C (95°F).
7. Cure the parts in the NextDent LC-3DPrint Box for the time specified in the User Guide .

3.2.7 Frequently Asked Questions

3D Sprint Questions

QUESTION ANSWER

Why can I not create a stack with multiple parts? You can create a stack with multiple parts, but the parts will
have to be combined into one part.

Why is Sprint taking a while to create a stack? This could be a result of the number of parts you are planning
to stack, and/or part file size.

Why is Sprint running slow when creating struts? There could be so many parts that it is slowing the system
down. Make sure View Neighbors is on when creating struts.

I cannot see the inside of my part because there are too many
struts, or the parts are too close together.

Use the clipping tool in VIEW in x/y/z. Make sure to turn off
"outline" when viewing a stack. You can make your clipping
planes visible in one direction or another to help with strut
point placement. Otherwise, you can hide parts in the parts
list by selecting the parts you want hidden and selecting the
eye icon next to one of those selected parts.
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QUESTION ANSWER

Why can I not create struts on another strut? Make sure to use CTRL + Left Mouse Click to add points on a
strut.

Printing

QUESTION ANSWER

What if my print fails because the base did not stick onto the
platform?

Make sure that the print platform and resin-tray membrane
are clean. Also make sure to mix the print material.

What if my parts fall off of the struts or base? Make sure you have added enough struts, and that you are
supporting any down-facing bottom layers. Otherwise, edit
strut parameters to be thicker.

3.3 Figure 4 Standalone Best Practices Premium Plus Build Style
The new Premium Plus build style is found in the PRO-BLK 10, Rigid White, and HI TEMP 300 AMB materials. The intention of
this build style is to further open the print capability tools so the user may print parts or platforms of parts that may have
previously been difficult within the system using Draft, Standard or Premium build styles.

The Premium Plus build style will be a slower print than the
Premium build style and will generally print up to 3X longer
print times. However, the longer print time allows for the part
to be accurately printed where it previously may not have
been possible to print well on the Figure 4 system due to
geometry constraints.

3D Systems, Inc. 80 p/n 42-D113, Rev. N



The Premium Plus build style is best used for the following:

• Large thick parts that are difficult to print square and
without distortion.

• Dense platforms which includes many parts in a single
print or thicker cross sections.
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3.4 Figure 4 Standalone Best Practices Premium Thick
The new Premium Plus build style is found in the PRO-BLK 10
material. The intention of this build style is to further open
the print capability tools so the user may print very thick parts
that would not have been possible within the system using
Draft, Standard or Premium build styles.

The Premium Thick build style is best used for the following:

• Large thick parts that are not possible to print square and
without distortion in previous build styles.

© by 3D Systems, Inc. All rights reserved. Specifications subject
to change without notice. 3D Systems, the 3D Systems logo
are registered trademarks and Figure 4 Standalone and Figure
4 are trademarks of 3D Systems, Inc.

3D Systems, Inc.
333 Three D
Systems Circle |
Rock Hill, SC |
29730
www.3dsystems.co
m

Rev. M, P/N 42-D114

3D Systems, Inc. 82 p/n 42-D113, Rev. N

http://www.3dsystems.com
http://www.3dsystems.com


3D Systems, Inc. 333 Three D Systems Circle Rock Hill, SC 29730
www.3dsystems.com

Register Statement
© 2023 by 3D Systems, Inc. All rights reserved. Specifications subject to
change without notice. 3D Systems and the 3D Systems logo are registered
trademarks of 3D Systems, Inc.

Copyright © 3D Systems, Inc. All rights reserved. p/n 42-D113 Rev. N


	TABLE OF CONTENTS
	1 Figure 4 Standalone Best Practices Print Material Quick Reference
	2 Figure 4 Standalone Best Practices General Post-Processing Tips
	3 Figure 4 Standalone Best Practices 3D Sprint
	3.1 Figure 4 Standalone Best Practices Materials
	3.1.1 Figure 4 TOUGH CLEAR
	3.1.1.1 Best Practices
	3.1.1.2 Maximum Z-height
	3.1.1.3 Supports
	3.1.1.4 Overhangs and Self-Supporting Angles
	3.1.1.5 Best Practices to Prevent Print Distortion
	3.1.1.5.1 Tall, Straight Features
	3.1.1.5.2 Bubbles
	3.1.1.5.3 Heat Distortion
	3.1.1.5.4 Part Finishing


	3.1.2 Figure 4 EGGSHELL-AMB 10
	3.1.3 Figure 4 ELAST-BLK 10
	3.1.4 Figure 4 FLEX-BLK 10
	3.1.5 Figure 4 FLEX-BLK 20
	3.1.6 Figure 4 High Temp 150C FR Black
	3.1.7 Figure 4 HI TEMP 300-AMB
	3.1.8 Figure 4 JCAST-GRN 10
	3.1.9 Figure 4 JEWEL MASTER GRY
	3.1.10 Figure 4 MED-AMB 10
	3.1.11 Figure 4 MED-WHT 10
	3.1.12 Figure 4 PRO-BLK 10
	3.1.13 Figure 4 RIGID GRAY
	3.1.14 Figure 4 Rigid White
	3.1.15 Figure 4 RUBBER-65A BLK
	3.1.16 Figure 4 RUBBER-BLK 10
	3.1.17 Figure 4 TOUGH 60C WHITE
	3.1.18 Figure 4 TOUGH 65C BLACK
	3.1.19 Figure 4 TOUGH-BLK 20
	3.1.20 Figure 4 TOUGH-GRY 10
	3.1.21 Figure 4 TOUGH-GRY 15
	3.1.22 Figure 4 Rigid 140C Black

	3.2 Figure 4 Standalone Best Practices Stacked Printing Workflow
	3.2.1 General Tips
	3.2.2 Build Setup
	3.2.3 Stack Setup
	3.2.4 Support Generation
	3.2.4.1 Manual Support Generation
	3.2.4.2 Semi-Auto Support Generation
	3.2.4.3 Supporting Textured Surfaces
	3.2.4.4 Advanced Stack Support Techniques

	3.2.5 Create Struts
	3.2.6 Printing and Post-Processing
	3.2.7 Frequently Asked Questions

	3.3 Figure 4 Standalone Best Practices Premium Plus Build Style
	3.4 Figure 4 Standalone Best Practices Premium Thick


